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Solution Overview

Solution Overview

OneStream Application Control Manager is a MarketPlace solution designed to support and
manage user change requests and ensure the right level of control and governance over application
changes.

With Application Control Manager, you can:

« Read and detect metadata changes in GL/ERP, data warehouses, and MDM tools and
synchronize changes to OneStream.

« Provide an easy way for users to request changes to OneStream applications. For example,
new or updated accounts, cost centers, other dimensions and user privileges.

« Ultilize multi-level approval workflow for change requests.
« Create audit reports on application change requests
« Manage metadata changes across environments (Dev-Test-Prod).

« Export metadata changes back to source systems.
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Setup & Installation

Setup & Installation

This section contains important details related to the planning, configuring, and installation of your
solution. Before you install Application Control Manager, familiarize yourself with these details.

See also:MarketPlace Solution Modification Considerations

Dependencies

Component Description

OneStream 6.3.0 | Minimum OneStream Platform version required to install this version of
or later Application Control Manager.

Select the Application Control Manager
Development Location

Before beginning installation, decide whether to build Application Control Manager directly in the
Production OneStream application or in a separate Development OneStream application. This
section provides some key considerations for each option.

Production OneStream Application: The primary advantage of building Application Control
Manager in a Production application is that you will not have to migrate the resulting work from a
Development application. However, there are intrinsic risks when making design changes to an
application that is being used in a Production capacity and this is seldom advised.

Note: Itis strongly recommended that you implement Application Control Manager in the
Development environment with a fresh copy of the Production application before starting
work.

Development OneStream Application: As a Best Practice, use the Development OneStream
application to build Application Control Manager.
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Create the OneStream Development
Application

1. Ensure all the OneStream artifacts relating to Application Control Manager such as Workflow
Profiles and Entities are in the Production application.

2. Copy your Production OneStream application to your Development environment and rename
it. This Development version will be used for your Application Control Manager project.

Application Server Settings

You may need to edit the OneStream application Server Configuration so users can create and
change data in the additional database tables used by Application Control Manager. If other
MarketPlace Solutions (such as Specialty Planning) are already in the application, these
adjustments may already exist.

See also:Solution Database Migration Advice

Configure the OneStream Application Server

Be sure that the security group settings include the users who will be working on and setting up
Application Control Manager before proceeding.

Note: Group settings are applicable to all MarketPlace solutions; it is important to keep the
group names generic.

1. Start the OneStream Server Configuration Utility as an Administrator.
2. Select Open Application Server Configuration File > Database
3. Editthe following OneStream Database Server properties:

o Access Group for Ancillary Tables: Select a group that includes those who will access
records.

« Can Create Ancillary Tables: True

« Can Edit Ancillary Table Data: True
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« Maintenance Group for Ancillary Tables: Select a group who will edit and maintain tables.

« Table Creation Group for Ancillary Tables: Select a group who can create tables.

OneStream Database Server properties:

=41 |
Azure Database Connection Settings
Connection String Settings

~ General
Access Group for Ancillary Tables IDB_AM:_Am_GmLp Id—
Allow Database Creation via Ul True
Can Create Ancillary Tables True
Can Edit Ancillary Table Data True
Database Provider Type SqlServer
ls BExtemal Database
Maintenance Group for Ancillary Tables lE:EﬁM: Maintenance Group I-'!_
Name OneStream Database Server
Table Creation Group for Ancillary Tables Everyone
Use File Groups when Creating Databases True
Use Table Partitioning when Creating Databases True

4. Restart Internet Information Server.

Install Application Control Manager

1. Onthe OneStream MarketPlace Dashboard, click MarketPlace > Application Control
Manager.

2. Onthe Application Control Manager Solution page, select the appropriate OneStream
platform version from the Minimum Platform Version drop-down list.

3. Select the most recent version from the Solution Version drop-down list and then click
Download.

4. Loginto OneStream.

5. Onthe Application tab, click Tools > Load/Extract.

6. Onthe Load tab, locate the solution package using the Select File icon and click Open.
7. When the solution’s file name appears, click Load.

8. Click Close to complete the installation.
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Set Up Application Control Manager

The first time you run Application Control Manager, you are guided through the table setup process.
In OneStream, click OnePlace > Dashboards > Application Control Manager > Application
Control Manager.

(oL LUIETW-l Application  System
= Workflow -

B Cube Views -

4 % Application Control Manager

|4 Application Control Manager

Create Tables

1. Click Step 1: Setup Tables
This step may be necessary when upgrading even if tables are already present. Application
Control Manager will not drop any tables that already exist but will modify table structures and
add any new ones if necessary.

2. When setup is complete, click Step 2: Launch Solution to open Application Control
Manager.

Package Contents

The Application Control Manager is the user interface for settings and application governance. The
following Business Rules are included:

o ACM_ImportMetadata
o ACM_AccountSource

ACM_EntitySource

ACM_MetadataSource

« ACM_UD1-8Source

ACM_DataSet
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« ACM_Reports

« ACM_Engine

o ACM_Validations

« ACM_Param

o« ACM_CreateFlowViews
« ACM_CreateRequest

« ACM_MetadataCommit
« ACM_Metadatalmport
o ACM_PrepareMetadata

Data Management Sequences and Steps are created for use with their related Business Rules. The
benefit of running these processes through a Data Management Sequence is that they can run in the
background while the user continues their work.
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Application Control Manager
Dashboard

In the Application Control Manager dashboard, use the toolbar buttons to navigate to different
pages.

- Home: Create, edit, manage, claim, push back, reject, and commit requests
« Reports: Run reports on requests

« Administration (Admin Only): Define and create request views, flows, dimensions,
properties, and validations

« Settings (Admin Only): Global settings for the solution. Most settings are configured once
during the initial install and don’t need to be updated on an ongoing basis.

« Help: View the documentation

Home

The Home page is the entry point for the solution.

APPLICATION CONTROL MANAGER g (2

® 2 @ Q¥ ¥ © O ® &

My Requests M

Create Edit Manage View Claim Unclaim  Regress Reject = Commit Recent

+ = O H | Master Request ol
ID T Request Type T Reason Y status T Step Label ¥ Priority T Created By ¥ Claimed By ¥ LastModified T
ROO0D0005 Metadata Request - Add/Update/Move Entity Business updates  InProcess  Initiate Medium Mancy Badger 3/2/2021 T:33:09
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Home Toolbar

« Create: Create a new request
« Edit: Update an existing request
« Manage: Redirect to Manage Request to add/update items

« View: View an existing request in read-only mode. Request Workflow and Save buttons are
not displayed so the request cannot be edited.

« Claim: Claims the request so the current user can work on it. Removes this request from the
queue of other users.

« Unclaim: Puts the request back into the queue as Unclaimed for other users to claim.
o Regress: Pushes the request back to a prior step. (Admin Only)

« Reject: Rejects and close the request.

« Remove: Sets the status of the selected request to Closed

o Commit: Manually launches the Commit Data Management sequence to commit all requests
currently at the Commit step with a status of Waiting.

Request Filter Bar

HOME

= r - ) —

® 2 @B Q¥ ¥ ©@ O ® m &

Crste  Edl  Msnsge  View  Cam  Undeim Regress  Refect | Commit | MY Requests "] Recent
My Requests

= = O H | Master Request v q 7l
My Actions

ID T Request Type T Reason Y | st My Queue arity

R0O0000005 Metadata Request - Add/Update/Move Entity  Business updates In Active Requests dium
All Recent

« My Requests: Shows requests the current user has created

« My Actions: Shows requests where the current user has an action to take
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« My Queue: Shows requests where the current user is in the group that has the next action to
take (for example, Enrich group)

« Active Requests: Shows requests that are currently active, not in a closed, completed or
committed status

« All Recent: Shows all requests in any state from the last XX days as configured in the next
option

: Configures how many days to view in the All Recent filter.

D Recent Days 0 ox
Recent Days: IZI

Close

Request Detail

ltems &l Documents

Drag a column header and drop it here to group by that column

Action T Dimension ¥ ParentMName T Member Name Y Description T Motes T validated Y Committed Y ParentinRequest T

ADD HoustonEntities Houston West Houston [

ADD ‘West Houston Katy [ ] []

Request Activity Add Comment Hide Show
= O H | Activity Log 2l
Username ¥ T\'mestarl:p T ActivitySummary A4

3/1/2021 10:13:08 PM  Added Item : Action: ADD Dimension: HoustonEntities ParentMame: West Houston MemberName: Katy Description:
3/1/2021 10:11:44 PM  Added Item : Action: ADD Dimension: HoustonEntities ParentMame: Houston MemberName: West Houston Description:

3/1/2021 10:01:21 PM  Request Updated : Updated by

« Items Table: Shows summary information of the items created on the selected request
« Documents: View documents attached to the selected request

« Request Activity: View the activity log for the selected request and add comments to it

Manage Request

On the Manage Request page, you can:
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Move a request forward or backward in the request flow.

Reject a request.

« Validate items in a request.

Create or delete request items.

Attach, delete, and download documents.

Request Summary and Workflow Buttons

MANAGE REQUEST

5 ¥ 0 © v ©
Home #R00000005 - Metadata Request - Add/Update/Move Entity (Initiate) UrEkmr famme ren VilEdE GG

« Request Summary
o RequestID, Type, Current Step and Reason
« Request Workflow Buttons

o Unclaim: Puts the request back into the queue as Unclaimed for other approved users
to claim and redirects back to the Application Control Manager Home page.

o Remove: Rejects and closes the current request. You can no longer edit the request
after this action.

o Revert: Pushes the request back to the previous step in the request flow.
o Validate: Checks the validation status of all items in the current request.
o Advance: Moves the request to the next step in the request flow.

o Home: Redirects to the Application Control Manager Home page.

Request Buttons
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Add: Opens a dialog box to create a new item.

« Remove: Deletes the selected item.
« Attach: Opens file explorer to attach a supporting document.
« Delete: Deletes the selected document.

« View: Downloads the selected document.

Item Table and Documents

ltems nl Documents

Drag a column header and drop it here to group by that column

Action ¥ | Dimension T |Parent Name ¥ Member Name Y | Description ¥ | Notes ¥ | Validated Y Committed ¥ | ParentinRequest ¥
ADD HoustonEntities Houston West Houston L}

ADD HoustonEntities West Houston  Katy (] (]

« Item Group: For Grouped Request Types (such as Cost Center), shows the Item Name of
the Group Parent Item.

« Subltem: True/False, indicates if the item is a sub item of a Grouped Item. Only valid on
Grouped Request Types.

« Action: The metadata action to be performed at the Commit step.

« Dimension: OneStream dimension to be updated at the Commit step.

« Parent Name: OneStream parent member name.

« Member Name: OneStream member name.

« Description: OneStream description.

« Notes: Aninput text field that is specific to the particular item.

« Validated: True/False, indicates if all item properties are valid.

« Committed: True/False, indicates if an item has been successfully committed.

« ParentinRequest: True/False, indicates if the Parent is included in the request.

Application Control Manager Guide
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Item Detail and Item Buttons

Enter or review properties for the item. Properties displayed here are set on the associated view.

ITEM DETAIL HoustonEntities ADD O B
Approvers  Note

Item Details Value

* Name Katy

Default Description

Is the Parent included in the current request? ®
* Parent Member Selector
West Houston

* Currency usD
Reference Entity Houston Heights
Is IC True
Is Consolidated Entity True

O ya
I:CI N

Recalculate  Validate

L)

Save

« Approvers: Add approvers to the current item.

« Note: Enter a note for the current item.

« Recalculate: Recalculates or refreshes the values for any calculated properties assigned to

the view.

« Validate: Runs validations assigned to the current item.

« Save: Saves the current item properties.

Request Activity

View a running log of the current request activity. Click Add Commentto include additional

commentary for the request.

Application Control Manager Guide
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Reports

Reports display in grid or PDF view.

- Bridge Metadata Report: Displays all metadata changes made and the requester, action
and status within Application Control Manager.

« Request Audit: Displays all requests made within a specified time.

« Request Audit by Request Type: Displays the audit report specified by request type.
« Request Audit by Status: Displays the audit report by status.

« Request Audit by Step Type: Displays the audit report by step type.

« Automated Request Audit with Item Detail: Displays all requests that were automated
from a source system into Application Control Manager.

« Request Activity Audit: Displays all activity that has happened in a specified audit time.

Export Report Data

To export the data, right click anywhere on the table, select Exportand then select the format for
export:

o Excel XML
« CSV
o Text

« HTML

Administration

On the Administration page you can define controlled governance:
« Metadata: Set up dimensions, actions, and imports.

« Security: Enable and disable allowed security actions.
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« Properties: Works with OneStream-defined properties and custom properties.
« Validations: Business rules can be set up to ensure user entry is appropriate.

« Views: Create and edit views. Assign properties and validations to views.

« Flows: Create the steps in the request approval process.

« Reports: Create custom report sets.

« Exports: Create and copy export groups and files.

« Logs: View log details.

Metadata

Provides options for the metadata governance set up of Application Control Manager. There are
three tabs for metadata information:

« Dimensions
« Actions

o Source System Imports

Dimensions Tab

Use this tab to manually define the dimensions that you want to be able to update in a request.

Metadata GOVERNANCE OPTIONS

Security Dimensions | Actions | Source System Import

Properties = = O H | Dimension

Validations P

Views Label ¥ Cube ¥ | Dimension Y DimName Y MemberFilter V|

Flows Account Houston | Account A#Root.Tree

Reports CorpEntities Houston | Entity CarpEntities E#Root.Tree

Exports Entity Houston | Entity E#Root.Tree

Logs HoustonEntities| Houston | Entity HoustonEntities E#Root.Tree
ub1 Houston = UD1 UD1#Root.Tree
upz2 Houston | UD2 UD2#Root.Tree
uD3 Houston | UD3 UD3#Root.Tree
uD4 Houston = UD4 UD4#Root.Tree
ubs Houston | UD3 UD5#Root.Tree
uDé Houston | UD6 UD&#Root.Tree
uo7 Houston | UD7 UDT#Root.Tree
upa Houston | UD& UD&#Root.Tree

Application Control Manager Guide
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Label: Unique label for the dimension. Click = to add a new dimension.
Cube: Cubes in the current OneStream application.

Dimension: OneStream dimension types.

DimName: OneStream dimension names.

MemberFilter: Text input field to assign the default member filter associated with this
dimension.

Grouped: Default is False. Set to True to create a Grouped Dimension type. If enabled, when
anew item s created, an item is created for each dimension defined in the GroupedDim
property. The “Grouped” dimension is not a true OneStream dimension and is not committed
to the Metadata Dimension Library.

GroupDim: A comma-separated list of the dimension labels that you want to group together.

Actions Tab

Use this tab to enable or disable actions.

Views
Flows
Reports
Exports
Logs

Metadata
Security
Properties

Validations

GOVERNANCE OPTIONS

Dimensions | Actions | Source System Import

+ = O H | Action
Mame T Label T Request Type: ¥ Enabled T
ADD Add New Member Metadata L]

COPY Copy Existing Member Metadata L]

DELETE | Delete Existing Member = Metadata

MOVE Move Existing Member =~ Metadata L]
REMOVE | Remove Relationship Metadata L]
UPDATE | Update Existing Member Metadata L]

Name: Unique name for the action in Application Control Manager. These actions are not
editable and do not allow additions.

Label: Display name of the action in Application Control Manager.
Request Type: The type of request that uses the action in Application Control Manager.

Enabled: Enable or disable actions for your Application Control Manager design.
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Source System Import Tab

Use this tab to manage source import options of Application Control Manager.

Metadata 'GOVERNANCE OPTIONS
securty | | Dimensions | actions | source system import |
Properties |Z|
Validations

Import
Views

x

Flows @ C

Process  Truncate
Reports
Exports Data Management Steps
Logs Group Name T Mame T Description ¥

Application Control Manager Metadata Import (ACM) Commit_ACM
Application Control Manager Metadata Import (ACM) Load Accounts_ACM
Application Control Manager Metadata Import (ACM) Load Entities_ ACM
Application Control Manager Metadata Import (ACM) Load UD1_ACM
Application Control Manager Metadata Import (ACM) Load UD2_ACM
Application Control Manager Metadata Import (ACM) Load UD3_ACM
Application Control Manager Metadata Import (ACM) Load UD4_ACM
Application Control Manager Metadata Import (ACM) Load UD5_ACM
Application Control Manager Metadata Import (ACM) Load UD6_ACM
Application Control Manager Metadata Import (ACM) Load UD7_ACM

Application Control Manager Metadata Import (ACM) Load UDB_ACM

« Process: Launches the data management step selected in the table.

« Truncate: Truncates the member and tree tables for the selected dimension.

Security

Provides options for the security governance set up of Application Control Manager. You can
manage the settings for security-type requests on the Actions tab.

[Note: You cannot add additional actions.

Metadata SECURITY OPTIONS

Security Actions

Properties = O H | Action
Validations =

; Mame T Label Y Enabled T

Views I

Flows ADD Add New User ]

Reports REMOVE | Remove Existing User| [

Exports UPDATE | Update Existing User | (@
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« Name: Unique name for the action.
« Label: Display name for the action.

« Enabled: Enable or disable the action.

Properties

Properties are values that you want a user to be able to update. There are two types of properties:

« OneStream defined properties, such as any of the built-in metadata properties.

« Custom properties, which you can create to hold additional information

Properties can be assigned to property categories to better organize common properties or

dimension-specific properties into groups.

Properties are attached to views.

Properties Tab

Matadata PROPERTIES
Security Properties | Categories | Lists | Request Table | Item Table
Properties @ &
Validations e . Export
Views + = O H | Properties ]|
Flows < —
Reports Flow Type Y Property Name T Label Y Flow Property ¥ Component Type ¥ Parameter Type Y | Parameter Name
Exports Metadata AccountType Account Type Combo Box Delimited List PROPERTY_AccountTyr
Logs Metadata AggregationWeight Aggregation Weight Text Box Input Value
Metadata AllowAdjustments Allow Adjustments Check Box Input Value
Metadata Allowinput Allow Input Check Box Input value
Metadata AlternateCurrencyForDisplay Alternate Currency Fo Combo Box Delimited List PROPERTY_AlternateCu
Metadata AutoTranslationCurrencies | Auto Translation Curre List Box Delimited List PROPERTY_AlternateCy
Metadata ConditionalinputCategories  Cube Conditional Inpt Text Box Input Value
Metadata Currency Currency Combo Box Delimited List PROPERTY_Currency_A
Metadata DataCellAccessCategories Cube Data Cell Access Text Box Input Value
Metadata DataMgmtAccessCategories | Cube Data Managems Text Box Input Value

Flow Type: Specifies the type of flow this property belongs to. Available options are: Metadata,

Capital, Security, and Generic.

Property Name: Unique property name. Click #* to add a new property.

Label: Descriptive label to be used across the solution.

Application Control Manager Guide
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Flow Property?: Indicates if the property can be assigned at the flow level.

Component Type: List of dashboard components you can assign to a view. These are the same as
the default OneStream components:

» Check Box

« Combo Box

« List Box

« Member Selector
o TextBox

These are custom components leveraging OneStream components, but provide specific
functionality for Application Control Manager:

« Parent Member Selector: Member selector specifically for a Parent property, to distinguish
from a default Member Selector for other properties.

« Security Group Selector: Member selector that pulls from OneStream security groups.

« Alternate Hierarchy: Member selector that creates a copy of the current item and creates the
new member in an alternate hierarchy

Parameter Type: The type of parameter attached to the component:
o Literal Value
« Input Value
« Delimited List
» Bound List
o Member List
« Member Dialog

Parameter Name: If necessary, select an existing parameter to populate choices in the delimited
list, bound list, and so on.

Namespace: Indicates if the property is built in OneStream or is custom.

Default Value: Sets the default value for the property. The default value is blank.

Application Control Manager Guide 18
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Property Options: Optional. Name-value pairs used to override default settings throughout the
solution. Property option values can be strings or parameters in the OneStream format, for example,
| 'ParameterName! |.

IsName: Indicates that this property is a Name property. Used for Custom Name properties.

IsDesc: Indicates that this property is a Description property. Used for Custom Description
properties.

IsRef: Indicates that this is a Reference member.

IsParentName: Indicates that this property is a Parent Name. Used for Custom Parent
properties.

PropName: Used for custom properties. Set the OneStream property this should update.
DimTypeName: Overrides the default DimTypeName on Member Selector type components
Dimension: Overrides the default Dimension on Member Selector type components
MemberFilter: Overrides the default MemberFilter on Member Selector type components
CubeName: Overrides the default CubeName on Member Selector type components

Tooltip: Sets the tooltip on the component

Categories Tab

Property categories are used to organize similar properties or dimension-specific properties into
groups. Category groups are listed on the left. The properties assigned to the group are on the right.

Metadata

PROPERTIES

Security Properties | Categories | Lists = Request Table | Item Table
Properties = O H | Categories ] | &= = O L |
Validations rS
) Name ¥ | Description Property T
Views L
Flows All All Properties Reference Account (Referencefccount)
Reparts Flow Flow Properties Culture (UserCulture)
Exports Metadata Metadata Properties Reference UD7 (ReferencelUD7)
Logs 0s Onestream Properties Reference UDB (ReferencelUDE)
Security User Security Properties Text 2 (UserText2)
External Auth Provider Mame (UserExternalAuthProviderMame)
Text 4 (UserTextd)
Email {UserEmail)
Reference UD4 (ReferencelUD4)
Reference UD2 (ReferencelUD2)
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These property categories display when adding properties to views.

Lists Tab

On the Lists tab, you can create name-value pairs list to be used as references in properties. An
example of how you might use a property list would be for a drop-down list in a property.

Metadata PROPERTIES
Security Properties Categories Lists | Request Table | Item Table
Properties Select List O
Validations Currency Y| Create  Export
Views
= = O H | List Items - Currency
Flows < <
Reports Display ¥ Value ¥
Exports
Logs caD CAD
EUR EUR
Py Y
usD uso

Click Create to create a new list.

« Display: Display text that a user sees when interacting with the list. Click == to add a new list
member.

« Value: Value is used by the system when making changes.

Request Table and Item Table Tabs

The Request Table and Item Table tabs are system-generated and cannot be updated by the
administrator.

Validations

Validations are business rules that run to check that user input follows specific rules.
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Metadata VALIDATIONS
Security + = O H | Validations =
Properties Name Y | Label Y Failure Message 1
Validations
CostCenterUD6Parent | Parent Should be JDE_DPT or SAP_DPT JDE_DPT for JDE or SAP_DPT for SAP
Views
BaseMotAllowed For Parent selection boxes, do not allow base members. Selected Parent Member can not be a base member.
Flows
Report WalidateMameCharacters Da not allow invalid characters (ex. Spaces in names, any systé Name contains invalid characters.
eports
Exports CheckFormatCC Account base formatting: CC_JDE_, CC_SAP_ MName must begin with: CC_JDE_ for JDE or CC_SAP_ for
Logs ExistingUser Check if User already exists User with this Name already exists
InvalidCharactersDescription) Check for Invalid Characters Description contains invalid characters -
4 3
o v 13 Rows Page 1 of1
B 2
Validations Properties
CostCenterUD6Parent &l
Assigned Views | View Label | Assigned Properties

Name: Unique validation name.

Label: Description of validation.

Failure Message: Message that displays when the validation fails.
Class: All validations are set to script.

Parameters: The business rule and associated parameters needed to run the validation script.

Validation Business Rules

To run properly, all validation scripts should be created in the ACM_Validations business rule.
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Business Rules - ACM_Val

NI OHI® |« || £
Fi ® * R = Z | Y 83
» §3args i; I_Impcrts OneStream.Finance.Database -
» &5 BRApI 19 [HMamespace OneStream.BusinessRule.DashboardExtender.ACM Validations
. 208
> oG Snippets 21 = Puplic Class MainClass
22 |
23 = Public Functien Main(ByVal si As SessionInfo, ByVal globals As BRGlobals, ByVal api As Object, ByVal args
24 Try
25 Return Mothing
26 Catch ex As Exception
27 Throw ErrorHandler.Loghrite{si, Mew XFException{si, ex})
28 End Try
29 | End Functicn
38
31 "DEFAULT BUILT IN VALIDATIONS
32
33 "Application Control Manager Built-In Functions
34
35 © Public Function CheckValue(ByWal si As SessionInfo, ByVal value &s String, ByVal nvpParams As Dictionary(0
36 Try
37 Dim blnvalidated As Boolean = False
38
39 Dim nvpPParams As New MameValueFormatBuilder("Params", nvpParams)
48
41 If Not nvpPParams.GetValue("Value") = Nothing Then
42 Dim 1Value As List{Of String) = StringHelper.SplitString(nvpParams.Item("Value"), ",")}
43
44 I {Not value = String.Empty And 1value.Contains(value)) Then
45 blnValidated = True
46 End IF
47 End If
43
49 Return blnValidated
5
51 Catch ex As Exception
=] Theew Eremetandlar |anleisafed  Baw ¥ECwrantinnfsd  avil T
4 K] 3

Views

A view is what you want a user to see at an Application Control Manager step. Properties and
validations are assigned to views and then the view is assigned to a flow step.

Views Tab

Click New and Edit to create and edit views.
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Metadata EWS

Security Views | View Tabs

Properties Select View Type: O £

Validations Main Views T New  Edt  Export

:::: = - ‘E) H | Main Views

Reports Name T Label T RequestType T

Exports _AccountSource AccountSource Metadata

Logs Entity_aAdd_Approve Entity - Add - Approve Metadata
Entity_aAdd_Enrich Entity - Add - Enrich Metadata
Entity_Add_Initiate Entity - Add - Initiate Metadata

Entity_Move_EnrichApprove Entity Move - Enrich Approve Metadata

Entity_Maove_Initiate Entity-Move-Initiate Metadata
EntitySource EntitySource Metadata
UD1Source uUD1source Metadata
UD2Source UD2source Metadata
UD3Source UD3Source Metadata
UD4Source UD4Source Metadata

Name: Unique view name.
Label: Description of view. It's helpful to include dimension, step, and action.

Request Type: This is selected from a list after view creation. Available types are: Metadata,
Security, and Generic.

View Editor

To getinto a view, select a view and then click Edit.

Properties Tab: Consists of two lists: Available Properties and Assigned Properties.
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& View Editor

Update B
Save
Name  AccountSource Flow Type | Metadata -
Label AccountSource
Properties | validations
Filter: | OS - t+ 1 g 4+ = i
Available Properties - Metadata = = O H | Assigned Properties 7l
- ry Y
Name T Label v Property T | DisplayOrder ¥ Editable ¥ Required ¥ Calculate ¥ Custom Lab
AccountType Account Type Parent Name (Parer 0m
AggregationWeight Aggregation Weight » Name (Name) 1=
AllowAdjustments Allow Adjustments > | Default Description 2 m
AlternateCurrencyForDisplay Alternate Currency For Display < Text1 (Text1) 3 m
AutoTranslationCurrencies  Auto Translation Currencies Text2 (Text2) 4 m
SelectMember Base Member Selector « Text3 (Text3) 5 m
ConditionalinputCategories  Cube Conditional Input Categories Text4 (Textd) 6 m
DataCellAccessCategories  Cube Data Cell Access Categories Text5 (Texts) 7 m
DataMgmtAccessCategories Cube Data Management Access Categories Texts (Texts) 8 m
Currency Currency Tavt? Mavt?) am -
. »
DisplayMemberGroup Display Member Group o 45 Ry P 1 of1
. g ows age o
Close

The Filter drop-down list allows you to switch between property categories to quickly see which
properties are available to assign to the view.

Use the center arrow buttons to add or remove the currently selected property or all properties to or
from the assigned properties list.

Use the Assigned Properties toolbar to:

T : Move the selected property up in the display order.

« ¥:Move the selected property down in the display order.
. 2 Toggle the editable property for all assigned properties.
« 7 :Toggle the required property for all assigned properties.

« : Toggle the calculate property for all assigned properties.

« [7: Open awindow to select an existing view from which to copy all properties .
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+ = O H | Assigned Properties

Property T Displa}order ¥ Editable ¥ Required ¥ Calculate Y | Custom Label ¥ Options Y|
| Parent Mame (ParentMame) om

Mame (Mame) 1. Account Mame
Default Description (Description) 2/m

Text1 (Text1) 3 m

Text2 (Text2) 4m

Text3 (Text3) 5|

Textd (Textd) 6 |

Texts [Texts) 7w

Texts [Texts) g m

Text? (Text?) 9=

Textd (Text8) 10 =

After you assign the property to the view, configure the following settings:
« Display Order: Order property displays on the view.

« Editable: Indicates if the property can be edited.

« Required: Indicates if the property is required. If True, it will not pass validation if left blank.

« Calculated: Indicates if the property is calculated based on another property.

« Custom Label: Overrides the property label.

« Options: Name Value pairs that are used for solution functionality.
o Tooltip: Overrides the property tooltip.
o UseRef: Use the property values from the Reference member assigned in the view.
o DimTypeName: Override the DimTypeName for the property.

« Validations Tab: Assign validations to views.

To assign validations to views:
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1. Use the arrows to assign validations to the view.

_ Validations

Available Validations

Name
CheckDateFormat
CheckFormatCC
CheckFormatEntity
CostCenterUD6Parent
EntityText1Valid

ExistingUser

InvalidCharactersDescription’ Check for Invalid Characters

LengthEquals3
ParentMotValiduD2

ValidateNameCharacters

Assigned Validations

T Label Validation
Make sure text is a Date

Account base formatting: CC_IDE_, CC_SAP_
Entity base formatting: ENT_

Parent Should be JDE_DPT or SAP_DPT

Text 1 Options: JDE, OTH or SAP

AR A v ¥

Check if User already exists

Length Restriction
For Parent UD2 selection boxes, do net allow PC

Do not allow invalid characters (ex. Spaces in na

MaxLength20

T Properties ¥

BaseNotAllowed

ExistingMember

2. Do one of the following:

« Select an assigned validation and then click £ to assign the validation to one or more

properties.

Properties | Validations |

Available Validations

Name
BaseMotAllowed
CheckDateFormat
CheckFormatCC
CheckFormatEntity
CostCenterUDeParent
EntityText1valid
ExistinghMember

ExistingUser

T | Label
Far Parent selection boxes, do not allow base
Make sure text is a Date
Account base formatting: CC_IDE_ CC_SAP_
Entity base formatting: ENT_
Parent Should be JDE_DPT or SAP_DPT
Text 1 Opticons: JDE, OTH or SAP
Check if Member already exists

Check if User already exists

InvalidCharactersDescription Check for Invalid Characters

LengthEquals3

Length Restriction

ParentMotValiduD2

o

For Parent UD2 selection boxes, do not allow |,

A A Vv ¥

2

¥

Assigned Validations

Y

validation ¥ | Properties ¥

MaxLength20 Description

« Click I to copy validations from another view.
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a. Select the view to copy from and then click Copy Validations.

@) Copy View Object

Views: |Account w. Subltems - Initiate Y|

Copy Validations

Close

Flows

Flows represent the entire request approval process that a user completes when creating a request.

Click New and Edit to create and edit flows.

Metadata R
Security Flows
Properties @ 2 |§| %) E» 'D'
Validations MNew Edit Copy Create  Create All Delete All Export
Views + =0 H | Flows
Flows <
Reports FlowOrder T Mame T Label T Request Type ¥ SecurityGroup ¥ Enabled T
Exports I 1 EntitySource | EntitySource Metadata Everyone
Logs 2 AccountSource AccountSource Metadata Everyone
3 UD15Source UD1Source Metadata Everyone
4 UD25ource UD25ource Metadata Everyone
5 UD3Source UD3Source Metadata Everyone
6 UD4Source UD4Source Metadata Everyone
7/ UD5Source UD5Source Metadata Everyone
8 UD&Source UD&Source Metadata Everyone
9 UDTSource UDTSource Metadata Everyone
10 UD8&Source UDaSource Metadata Everyone
11 MF_Entity_1 Metadata Request - A Metadata Everyone L]

Flow Editor

Summary: Properties associated with the flow.
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@ Flow Editor 0 ox

Update - AccountSource 2z B

Edit Save

* Name AccountSource Order 2

*Label  AccountSource Enabled? Use Tabs?
Category | Metadata T Multiple tems? = Modify Approvers?

Security Group | Everyone - Error Template | Error ~ Error Email

o Order: The order the request type displays in the drop-down list when a user creates a new
request.

« Name: Unique request flow name.

« Label: Descriptive label that users see for the request type.

« Enabled: Determines if the request type is visible in the new request drop-down list.
« Use Tabs?: Determines if the flow is using multiple tab views.

« Category: Available options are: Metadata, Capital, Security, and Generic.

o Multiple Iltems?: Determines if the request allows more than one item in the request.

« Modify Approvers?: Determines if the user is allowed to select the approver from a drop-
down list of approver users.

« Security Group: Indicates who can initiate these types of requests.
« Error Template: Email template sent out for errors at the flow level.
« Error Email: Email group that receives flow error emails.

« Edit: Allows you to add a flow property to the flow level.

« Save: Save updates to these properties.

Steps Tab

These are the steps in the approval process.
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Steps Options | Views

2

Edit

+ = O H | Steps - Metadata Request - Add/Move/Update Entity

Order ¥ Step Type ¥ Label ¥ Security Group ¥ Notify ¥ Email Template ¥ Email Address ¥

1 Initiate Initiate  Everyone Participants  Default
2 Process Enrich Everyone Participants = Default
3 Process Approve Everyone Participants = Default
4 Commit Commit Everyone Participants  Default

o Order: Step order. The Commit step is always the last step for metadata requests.

Step Type: Built-in step types.

Label: Unique label for flow-step combination.

« Security Group: Specify which group of users has access at each step.

Notify: Select who gets notified on this step. ** Not currently implemented, only notifies email
address defined.

o None, Assignees, Participants, Assignees and Participants

Email Template: Select the email template to use for notification.

Email Address: Email group to be notified when the request is at the current step.

Options Tab

For Metadata request types, assign the dimensions to work with on this request type and then assign
the actions to perform for each dimension.

Steps | Options | Views

Flow Dimension: ﬁ
CorpEntities M LES—E‘"
Flow Options
Dimension ¥ | Actions T
HoustonEntities ADD,MOVE,UPDATE

Assign Actions
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@) Edit Flow Actions O ox
HoustonEntities - Assign Actions
Available Assigned
COPY ADD
REMOVE » | move
> UPDATE
<
«
Close
Views Tab

The Views tab allows administrators to assign the previously created views to each individual step-
dimension-action in the flow process. The list is automatically created when you add a new step or
option. You must select the Assigned View from the drop-down list. To edit an assigned view, select
the view step and then click Edit.

Steps | Options | Views |

=
C ® 2 B
| i — |
Refresh MNew Edit Create
= = O H | View Assignments
step T ViewAssignmentLabel Y Options T Assigned View T

Approve | (Approve) [HoustonEntities ADD] HoustonEntities ADD Entity - Add - Approve
Approve | (Approve) [HoustonEntities MOVE] | HoustonEntities, MOVE Entity Move - Enrich Approve
Approve | (Approve) [HoustonEntities, UPDATE] Houstonkntities, UPDATE  Entity - Add - Approve

Enrich (Enrich) [HoustonEntities, ADD] HoustonEntities, ADD Entity - Add - Enrich

Enrich (Enrich) [HoustonEntities, MOVE] HoustonEntities, MOVE  Entity Move - Enrich Approve
Enrich (Enrich) [HoustonEntities UPDATE] HoustonEntities, UPDATE  Entity - Add - Enrich

Note: If the View Assignment list looks incorrect or does not seem to be updated, click
Refreshto manually refresh the list.

Create Dynamic Dashboard for Flow Views

After you create the flow and assign the views to each flow step, you must run a process to create
the dashboard components. Go back to the main Flows screen:
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Metadata LTINS

Security Flows

Properties @ £ |§| %; %»

Validations New Edit Copy Create  Create All Delete All Export

Views + = O H | Flows

Flows =

Reports FlowOrder T MName T Label T | Request Type ¥ | SecurityGroup ¥ | Enabled T

Exports I 1 EntitySource EntitySource Metadata Everyone

Logs 2| AccountSource AccountSource Metadata Everyone
3 UD1Source UD1Source Metadata Everyone
4/ UD2Source UD2Source Metadata Everyone
5 UD3Source UD3Source Metadata Everyone
6 UD4Source UD4Source Metadata Everyone
7 UD3Source UD5Source Metadata Everyone
8 UD6eSource UD&Source Metadata Everyone
9 UDTSource UDT7Source Metadata Everyone
10 UD8&Source UD&Source Metadata Everyone
11 MF_Entity_1 Metadata Request - & Metadata Everyone

« New: Create a new flow.
« Edit: Edit a flow.

o Copy: Copy a flow.

« Create: Create dynamic views for the selected flow.

« Create All: Create dynamic views for all flow.

o Delete All: Delete the selected row.

« Export: Export flows to a .CSV file for review in Excel or another text editor.

The dynamic dashboards are created in a specific Dashboard Maintenance Unit named Application

Control Manager Dynamic Dashboards (ACM). The dashboards can be reviewed here.

4 [™ Dashboard Maintenance Units
¥ ™ Application Control Manager (ACM)
¥ [ Application Control Manager Custom Dashboards (ACM)
4 [ ppplication Control Manager Dynamic Dashboards (ACM)
4 Dashboard Groups
P ** Dynamic Flow Content (ACM)
P ** Dynamic Item Content (ACM)

#* Dynamic Request Summary Content (ACM)
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Important: Do not make updates to the Dashboard here because any changes are
overwritten when the Create process runs. Only make updates using the View Editor.

Reports (Administrator)

The Reports page allows you to set up report sets for the Application Control Manager Reporting

page. Click  to access the Reporting page.

Report Sets

Use to group Application Control Manager reports into report sets.

ADMINISTRATION

Metadata BECHIRIN
Security Report Sets

Properties b =D H | Report Sets &l
Validations - i -
. Mame (Key) T Description Y Display Order T
Views L
Flows Default Default Report Set 10
Reports CustomReports Custom Reports 20
Exporis
Logs

== Add a new report set.

== : Delete selected report set.

« ¥J: Undo unsaved change.

IH : Save changes to the report sets.

The workspace has three main columns:
« Name (Key): Unique name for the report set.
« Description: More detailed description of the report set.

« Display Order: Arrange your report sets into numerical order.

Reports

When you click on a report set, the lower pane opens where you can add the reports to the set.
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d = O H | Default Reports 7l
Name (Key) ¥  Display Name Y Enabled Y Displa;Order T Security Group Y | Dashboard Name A
_Request.t\udit Request Audit L] 100 Everyone RequestAudit_ACM
RequestauditByType Request Audit By Request | (m 110 Everyone RequestByTypeAudit_ACM
RequestAuditByStatus Request Audit By Status | (m 120 Everyone RequestByStatusAudit_ACM
RequestAuditByStep Request Audit By Step Typ & 130 Everyone RequestByStepType_ACM
RequestauditWithitem Request Audit with [tem C| (m 200 Everyone RequestWithitemDetailaudit_ACM
RequestAutoltemDetail  Automated Request Audit m 210 Everyone RequestAutoltemDetail_ACM
MetadataDetailaudit Metadata Detail Audit 500 Everyone MetadataDetailAudit_ACM
ActivityLogAudit Request Activity Audit [ ] 1000 Everyone ActivityLog_ACM
BridgeMetadataAudit Bridge Metadata Audit [] 1100 Everyone BridgeMetadataAudit_ACM

« % : Add areport to the set.

== : Delete selected report from set.

¥ : Undo unsaved change.

IH : Save changes to the report.

The dashboard has six columns:

« Name(Key): Unique name for the report.

« Dashboard Name: Name of the report dashboard in Application Control Manager.

The reports dashboard groups are in Application > Presentation > Dashboards > Application

Control Manager (ACM).

Display Order: Arranges reports in numerical order.

Display Name: The name of the report displayed to the end user.

Enabled: Determines if the report in the set can be seen by the end user.

Security Group: Assigns the OneStream security group that can view this report.

There are reports that come with Application Control Manager and are listed under Default Reports.
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Application @ Application Dashboards - ActivityLog_ACM (Dashboard)
Cub R —
4 ® Cube SEEEEEE R

4 [ Dashboard Maintenance Units

%, Dimensions

© Time Profiles o
4 [™ Application Control Manager (ACM)

£P Cubes
4 Dashboard Groups
&) FX Rates ) .
»** Admin Capital Content (ACM)
4 3 Workflow

** Admin Content (ACM)
=3 Workflow Channels o
** Admin Dialogs (ACM)
Workflow Profiles

[ 4

»

»** Admin Export Content (ACM)
[3 Confirmation Rules ]

»»* Admin Governance Content (ACM)
(@) Certification Questions ) )
»** Admin Security Content (ACM)
4 B Data Collection
4 »» Default Reports (ACM)
5 Data Sources —
|4 ActivityLog_ACM
=g Transformation Rules o
|25 ActivityLogReports_ACM
Form Templates o _
|4 BridgeMetadatafudit_ACM
Journal Templates o _
|z~ BridgeMetadatafuditReports_ACM
4 7 Presentation A o
|z MetadataDetailAudit_ACM

B Books A ]
- |4 RequestAudit_ACM
Cube Views
|#£ RequestAuditReports_ACM
|s& Dashboards .
|4 RequestAutoltemDetail_ACM
4 »Tools

Exports
On the Exports page, you can create and copy export groups and files.

ADMINISTRATION

Metadata EREEE

Security @l @ @

Pmper{igg Create Group Copy Group Create File Copy File

Validations = O k| =D H | ERP_PLaccounts Files

Views - B

Elows Export Group T | File Name Y Export Location ¥ | File Path Y File Extension ¥
Reports FERP_PLaccoums FileShare yGroups\Everyone\ACHM txt

Exports

Logs

Logs

Application Control Manager has detailed logging where administrators can view all of the
processing events including errors that have occurred in the solution.
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Click Refresh to refresh the detailed logging screen. Click Delete to clear all Application Control
Manager log files.

Settings

The Settings dashboard contains global solution configuration settings including initial setup,
uninstall, and custom database table administration.

Global Setup
Global Options

Global configuration options apply to the entire solution.

Global Setup Global Options | Global Security | Email Settings | Email Templates | Environments

Load/Extract

Uninstall Time Offset: 1

Detail Logging: =

Grouped Dims:

» Time Offset: Use to adjust the server time to the current time zone. This is the time stamp
used on all activities within the solution. The value is the number of hours to adjust and can be
a positive or negative number.
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« Detailed Logging: Enable the Logs Administration Screen item. Otherwise, only the
OneStream system logging is used.

« Grouped Dims: Enabled when one request needs to be applied to multiple dimensions.

Global Security

The global security tab is where you can assign security on who can manage Application Control
Manager.

Global Setup Global Options | Global Security | Email Settings | Email Templates | Environments

Load/Extract
Uninstall Security Role [Manage Setup]: | Administrators -

Allow Access to Administrators Group: =

« Admin Security Group: Select the OneStream security group that will be the Application
Control Manager Administrator.

o Allow Access to Administrator Group: Determines if the OneStream Administrator group
has administrator access in Application Control Manager.

Email Settings

Email settings allow you set up the email account used to send natifications from Application Control
Manager.

SETTINGS

Global Setup | Global Options | Global Security | Email Settings | Email Templates | Environments |
Load/Extract
Uninstall Server Config Name: OneStreamEmail

- OR ---

Email Server:

Email Port: -1

From Address:

UserName:

Password:
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« Server Config Name: Uses the email connection defined on the OneStream server. Or you

can set up a manual connection by filling in this information:

o Email server: Email service address

[}

Email Port: Port used by the email server settings

o

From Address: Email address which the messages should come from.

Username: Email username for the account

o

Password: Password for email account

o

Email Templates

Templates that are used for email notifications. You can use placeholders in the subject and
message of the email message.

SETTINGS

Global Setup Global Options | Global Security | Email Settings | Email Templates | Environments
Load/Extract

+ = O H | Email Templates @l
Uninstall

Label ¥ Subject Y  Message T

I . o Error whil i + for the follow :

Error RequestlD #requestid® Processing Failue rrorwhile processing request for the foflowing reason

#message#
Default  RequestiD #requestid®# Processing Information  Flow #flowname# was just advanced to the #flowsteplabel# step

Email Placeholder Options
» FlowName
o FlowType
» FlowLabel
« FlowStepLabel
o FlowStepType
« Message
« Priority

o PriorFlowStepLabel
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« RequestID

« Requester

« RequestStatus
« RequestReason

« RequestNextAction

Environments

Administrators can set up multiple environments to move metadata across environments.

Load/Extract

This screen allows you to load and extract components or the entire Application Control Manager
user interface.

Extract

Use to extract the configuration and components of Application Control Manager.

Global Setup
Load/Extract

Uninstall

EXTRACT LOAD

Extract All

Extract Single Config Table

b

Extract
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» Select Config Data to Export: Select the specific configuration piece that you want to
extract to a flat file for future import or backup.

« Extract All Config Data: Extracts all pieces of Application Control Manager configuration to
a flat file for future import or backup.

« Extract App Components: Extracts all solution components to a zip file for backup or
import.

Load

Use to delete and load the Application Control Manager configuration and components.

Global Setup EXTRACT | LOAD
Load/Extract

Uninstall -
Step1: Delete Config Data | |

r ‘L -K|
Step 2: Load Data V'

« Delete Config Data: Clears all current Application Control Manager configuration data. Use
this before importing new configuration data from file.

» Load Data: Imports configuration data from file.

Other

Use to extract the entire Application Control Manager user interface.

Uninstall

1. Inthe Application Control Manager Dashboard, click ©* and then, under Settings, click
Uninstall.

2. Select an option:

Application Control Manager Guide 39



Application Control Manager Dashboard

« Uninstall Ul to remove the dashboards, business rules and keep all the data in the
database tables. This is useful for updates to the solution.

« Uninstall Full to completely uninstall the solution including all components and data.
This drops the custom database tables and removes all dashboards. You can’t recover
from this unless you have backed up both the dashboards and data.
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Administration Tasks

Create a New Flow

To create a new flow for a request type:

-_—

10.

. Inthe Application Control Manager Admin Dashboard, navigate to Views.

Create a view for each step that will be in the request flow.
a. Assign the properties to the view.
b. Assign the validations to the view.

Navigate to Flows.

. Create a new flow and save it before adding steps, options, and views.

On the Steps tab, add the steps for your approval workflow.

On the Options tab, assign the Dimension-Actions combination that you want to be available
for this flow.

After all steps and options are added, on the Views tab, select the Assigned View for each
Step — Option combination.

Make sure the flow is enabled to make it available in the New Request drop-down list.
Save the flow and close the Flow Editor.

Run the Create Flow Views process.

Refreshing Dynamic View Dashboards

1.

Make the necessary changes to the view or flow that you want to update. Changes can be
updating a label, adding or removing a property, changing the order of the properties, adding
or removing steps in a flow.

. Go to Administration> Flows.
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3. Select the flow that you changed.

4. Click Create.

[Tip: If you want to refresh all dynamic dashboards, click Create All. ]

Metadata Import

Setup Data Sources

When Application Control Manager is installed, a default set of data connectors is installed. There is
one connector for each supported dimension:

» [ Fixed Files
» [ Delimited Files
4 [B Connectors
» [ ACM_AccountSource
» [ ACM_EntitySource
b [F] ACM_MetadataSourc
» [ AChM_UD1Source
» [F] ACM_UD250urce
» [ ACM_UD3Source
» [ ACM_UD4Source
» [ ACM_UDSSource
» [ ACM_UDSSource
» [F] ACM_UDTSource
» [ acM_UDSSource

These data sources are set up to connect to staging tables which are created during the Application
Control Manager installation process. These staging tables are named with the following format:
ACM_Metadata<dimension>ImportTree and ACM_Metadata<dimension>ImportMembers.
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The tables with "Members" in the name store the unique list of members from the source metadata
system. Each dimension table has a different set of properties that you can import into OneStream

but the Member field must always be populated:

The tables with "Tree" in the name store the overall hierarchy details. Each table contains four

columns.

= Columns
w0 [Dimension (PK, nvarchar(30), not null)
w0 Parent (PE, nvarchar(30), not null)
w0 Child (PE, nvarchar(30), not null}
E SortCrder (int, not null)

The Dimension column must be populated with the name of the Application Control Manager
dimension that you are loading. This is set up in the Application Control Manager Administration

screen:

Metadata 'GOVERNANCE OPTIONS

Security Dimensions | Actions | Source System Import

Properties + = DO H| Dimension

Validations S =

Views _Label ¥ Cube T Dimension ¥| DimMame T MemberFilter T

Flows Account Houston = Account A#RootTree

Repaorts CorpEntities Houston | Entity CorpEntities E#Root.Tree

Exports Entity Houston | Entity E#Root.Tree

Logs HoustonEntities Houston | Entity HoustonEntities | E#Root.Tree
up1 Houston | UD1 UD1#RootTree
uo2 Houston = UD2 UD2#Root.Tree
up3 Houston | UD3 UD3#RootTree
U4 Houston = UD4 UD4#Root.Tree
ups Houston | UD3 UD5#RootTree
uDe Houston = UD& UD6#Root.Tree
uo7 Houston = UD7 UD7#RootTree
uos Houston = UD8 UDB#Root.Tree
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The Parent and Child columns are populated with member names found in the Member column of
the associated Members table. SortOrder can be used to sort the hierarchy. If order is not important,
enter a value of 1 for all rows in the hierarchy table.

Workflow Profiles

When Application Control Manager is installed, a Workflow Profile named ACM_Metadatalmport_
Default is automatically created in your system. In addition, a special cube is created: ACM_
Metadatalmport.

ACM_Metadataimport v

4 P ACM_Metadatalmport
4 £ ACM_Metadatalmport_Default
Forms
B Ad
B AccountSource
f& EntitySource
B8 uD1source
E UD2Source
8 UD3Source
8 uD4Source
& UDS5Source
B uDsSource
B UD7Source
B3 upssource
8 migration

By default, the data source name for each dimension is set to utilize the data connectors mentioned
in the prior step.
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IACM_Metadatalmport - Calculation Definitions
Search ACM_Metadatalmport_Default.AccountSource - Properties [(Default)]
4 [P ACM_Metadatalmport (Default) 7| B General
4 A ACM_Metadataimport_Default Actual l\ame ___________________________________________ ACM_Metadatalmpaort_Default.AccountSourc
Forms Administration || Deseription :
B Adj Budget & Security
[ AccountSource Control Access Group Everyone
I Entitysource Flash Maintenance Group Everyone
& uD1Source Forecast ‘workflow Execution Group Everyone
I Ub2source FXModel Certification S..lgnOff Group Everyone
I Upssource History = Workflow Settings
- Workflow Channel Standard @
5 Ub4source Longtenm Workflow Name Import (Stage Only)
& upssource Model ‘Workspace Dashboard Mame (Custom Workflow) — (Unassigned) @) |
& upssource Cperational B Integration Settings
i uo7source Plan Data Source Name ACM_AccountSource &) | -
#§ upssource ScenarioTypel Transformation Profile Name ACM_ImportMetadata )| |
{8 Migration ScenarioType2 Import Dashboard Profile Name (Unassigned) @) |-
ScenarioType3 Validate Dashboard Profile Name (Unassigned) &) |-

Select the transformation profile named ACM_ImportMetadata. This is automatically created in your
environment when Application Control Manager is installed.

The Workflow Profiles are used to import the metadata loaded in the staging tables into the
OneStream staging tables. After the information is loaded, the metadata is analyzed to determine
differences that exist between the source data and the metadata stored in OneStream. The system
looks for differences in this order:

1. Missing members in the metadata as compared to the source system
2. Existing members that need to be migrated or copied to a different hierarchy
3. Updates to existing member properties.

If Application Control Manager finds any updates it builds a request in the system. The results of this
process are displayed on the main home page of Application Control Manager:

Metadata Import Fields

To map the import data to the metadata properties in OneStream, go to the Application Control
Manager Administration screen and select Views. A single view for each workflow profile is created
when Application Control Manager is installed. Select the one you want to modify and then click the
Edit button:
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VIEWS

Metadata

Security Views Tabs

Properties Select View Type: @ 2

Validations Main Views - - - Eport

e ‘ + = D H | Main Views

Flows

Reports |Name - Y Label ¥ RequestType ¥

Exports _AccountSource AccountSource Metadata

Logs _EntilyfAdd,Approve Entity - Add - Approve Metadata
_Entily_Add_Enrich Entity - Add - Enrich Metadata
7Entily_Add_ln|tiale Entity - Add - Initiate Metadata
_Entlly_Move_EnrichApprove Entity Move - Enrich Approve Metadata
7Entily_ane_Init\'ate Entity-Move-Initiate Metadata
_EntllySource EntitySource Metadata
_UD1Scurce UD1source Metadata
-UDZSource UD2Source Metadata
_UDSSource UD35ource Metadata
7UD4Source UD4Source Metadata
_UDSSource UD55ource Metadata
7UDGScurce UDsSource Metadata
_UD?Source UD7Source Metadata
_UDSScurce uDssource Metadata

On the right side of the dialog, you can see the list of metadata properties that map to the columnsiin

the database:

Update

Save
Name AccountSource Flow Type | Metadata M
Label AccountSource
Properties | walidations
Filter: | OS v *+ 4 = iy
Available Properties - Metad, = = O H | Assigned Pro [
- s -
Name T Label v Property Y DisplayCrder ¥ Editable ¥ | Required
AccountType Account Type Parent Name (ParentName) o [m
AggregationWeight Aggregation Weight »| Name (Name) 1/ [m
AllowAdjustments Allow Adjustments > || pefault Description (Description) 2 [(m
AlternateCurrencyForDisplay Alternate Currency For Display < Text1 (Text1) 3 m
AutoTranslationCurrencies  Auto Translation Currencies | Text2 (Text2) 4 m
SelectMember Base Member Selector « | Text3 (Text3) 5 m
ConditionalinputCategories Cube Conditional Input Categories | Texta (Textd) 6 (m
DataCellAccessCategories Cube Data Cell Access Categories | Texts (Texts) 7 m
DataMgmtAccessCategories Cube Data Management Access Categories | Text6 (Texts) s m
Currency Currency | Textr (Text7) 9= M
Pl »
DisplayMemberGroup Display Member Group
o ’ 45 Rows Page 1 of1
Clrusnmetrning Clruas Crmcraing i
| Close ‘

Application Control Manager Guide

46



Administration Tasks

These match the information in the database:

[=] Columns
wo Member (PK, nvarchar(30), not null)
E Text1 (nvarchar{230), null)
E Text2 (nvarchar{250), null)
E Text3 (nvarchar(250]), null)
E Textd (nvarchar(250]), null)
E Text5 (nvarchar(250]), null)
B Text6 (nvarchar(250), null)
E Text7 (nvarchar{250), null)
E Text8 (nvarchar(250), null)
E UD1 Constraint (nvarchar(230), null)
E UD2Constraint (nvarchar(230), null)
E UD3Constraint (nvarchar(230), null)
E UD4Censtraint (nvarchar{230]), null)
E UD5Constraint (nvarchar(250), null)
E UDBConstraint (nvarchar(250), null)
E UD7Constraint (nvarchar(230), null)
E UDEConstraint (nvarchar(230), null)
E EnableUD1Aggregation (nvarchar(250), null)
E EnableUD2Aggregation (nvarchar(230), null)
E EnableUD3Aggregation (nvarchar(250), null)
E EnablelUD4Aggregation (nvarchar(250), null)
E EnableUD3Aggregation (nvarchar(250), null)
E EnableUD8Aggregation (nvarchar(250), null)
E EnableUD7Aggregation (nvarchar(250), null)
E EnableUD8Aggregation (nvarchar(230), null)
E EnablelCAggregation (nvarchar(230), null)
B EnableOriginAggregation (nvarchar(250), null)
E EnableFlowAggregation (nvarchar(230), null)
E UsedOnEntityDim (nvarchar(250), null)
E UsedOnConsDim (nvarchar(250), null)
E Description (nvarchar(230], null)
E IsConsolidated (nvarchar(250), null)
E ICConstraint (nvarchar(250), null}
E Allowlnput (nvarchar{230), null)
E WorlflowChannel (nvarchar(250]), null)
E InUse (nvarchar(230]), null)
B AggregationWeight (nvarchar(250), null)

If you want to change the list of properties monitored and updated in OneStream, use the arrow
buttons to move fields in and out of the list. If you do this, you must modify the related Connector
Business Rule:
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[eINEV Application JESEEEN * E:Zr’ Business Rules
4 @ Cube R % OH 8|« w | B
%, Dimensions » [ Finance 1
® Time Profiles ¥ [ Parser
[P Cubes 4 [@ Connector
%] FX Rates +% ACM_AccountSource
4 (3) Workflow /% ACM_EntitySource
+3 Workflow Channels 7 ACM_MetadataSource
Workflow Profiles % ACM_UD1Source
(8 confirmation Rules X ACM_UD2Source
@ Certification Questions V% ACM_UD3Source
4 B Data Collection +X ACM_UD4Source
fE8 Data Sources +% ACM_UDSSource
=g Transformation Rules % ACM_UD6Source
Form Templates /% ACM_UD7Source
Journal Templates +x ACM_UD8Source
4 2 Presentation +% BiBlendBillings
il Books % BIBlendPayment
R Cube Views +/x CPP_CapitalPlanningData
|s& Dashboards +/% CPP_CapitalPlanningData_EntityTin
4 > Tools /% CPP_CapitalPlanningData_EntityTout
w Security Roles +/x C5P_CashPlanningData
[T Application Properties +% PaymentMgmtHouston
/% Business Rules +/% PLP_PecplePlanningData

In the business rules, find the GetFieldList method and associated method containing the SQL to pull
information from the database in GetSourceDataSQL. Make sure the fields match the order that
Application Control Manager has in the associated view.

Data Management Groups

The process of loading and committing metadata updates to OneStream is handled using Data
Management steps and sequences.
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4 *+* Data Management Groups
P *+ Admin
b=+ application Control Manager Create Flow Views (ACM)
b @+ application Control Manager Metadata Commit (ACM)
4 ##» ppplication Control Manager Metadata Import (ACM)
4 Ff sequences
Al Commit_ACM
4 o Steps
8 Commit_ACM
5 Load Accounts_ACM
5 Load Entities_ACM
5 Load UD1_ACM
H Load UD2_ACM
H Load UD3_ACM
B Load UD4_ACM
5 Load UD5_ACM
5 Load UD6_ACM
H Load UD7_ACM

2 Inad DR ACM

The data management steps are preconfigured when Application Control Manager is installed. The
Load items are set up to execute the workflow profile associated with the dimension name. The
process loads the data from the database into the OneStream staging tables, performs the
comparison process, and builds a request if necessary.

The associated Workflow Profile is in the parameters on the data management step:

‘,f Data Management - Load UD1_ACM (Step)
e & 2 | H B I % B OKHI+ T V=] B |88

4 »#* Data Management Groups + O General (Step)
B ®e Admin Mame Load UD1_ACM
b es Application Control Manager Create Flow Views (ACM) ?_P_E_S_tfr_ip_ti_cfﬂ ______________________________________
¥ s Application Control Manager Metadata Commit (ACM) Data Management Group Application Control Manager Metadata Import (ACM)
4 #»» Application Control Manager Metadata Import (ACM) Step Type Execute Business Rule
4 3 Sequences Use Detailed Logging False

& Commit_ACM B Business Rule

Business Rule
4 5 Steps ACM_Metadatalmpaort

2 Commit_ACM Parameters workflowProfileMame=UD1Source
S Load Accounts_ACM
5 Load Entities_ACM
8 Load UD1_ACM

5 Load UDZ_ACM

5 Load UD3_ACM

« WorkflowProfileName: Specify the name of the dimension you are importing for. This
matches the Workflow Profile as well as the WF Profile Name in the Metadata Import Fields
screen.

Ensure the business rule is set to ACM_Metadatalmport.

The execution of the steps Load <...> perform the following steps:
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1. Loads the data from the database or file into the workflow for the current global POV’s time
and scenario.

2. Compares the data loaded into OneStream to the existing members for the selected
dimension and determines what members need to be added.

3. Compares the data loaded into OneStream to the existing hierarchy for the selected
dimension and determines what updates are required to the overall hierarchy. In this step,
updates such as adding a new parent-child relationship and creating a new sub-hierarchy for
an existing set of members is.

4. Compares the data loaded into OneStream to the existing members and determines what
properties need to be modified.

5. Compares the existing members and hierarchy in OneStream to the data loaded into the
system to determine what members need to be removed from the hierarchy. Any member not
in the import file/table is marked as orphaned in OneStream. The member is not deleted.

6. Builds an Application Control Manager request which performs all the required operationsin a
single transaction.

After a request has been generated, the Commit All Metadata Updates data management step
executes to commit the updates to the system.

The Data Management Steps can be combined into a sequence to allow for the full automation of
the process using a PowerShell script and the Windows Task Scheduler on the OneStream
application server. You can automate the load and commit steps to include no user interaction
before commit or you can set the system up to require an individual on the Finance team to review
the request before manually committing it into the system.

Metadata Synchronization

Initial Setup and Configuration

The metadata migration and synchronization feature of Application Control Manager keeps the
metadata hierarchies between two OneStream installations/environments in sync with one another.
This is accomplished by utilizing the REST API built into OneStream. The configuration is completed
in the destination environment. The REST APl in the source environment requires setup on the
server side so ensure that the proper configuration is in place and request the following details for
your Azure Single Sign-On configuration from your technical support representative:
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o Azure AD TenantID

o OneStream Web Api Client ID

o OneStream Web Api Client Secret Key

» Source OneStream System URL

« Source OneStream System Application Name

The first three values can be found in the OneStream XFWebServerconfig.xml:

Enter these five values for the source OneStream environment into the Application Control Manager
Setup screen:

Start by adding a new source environment name in the left panel. This is for all environments that
you want to synchronize metadata from and into the current environment:
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Next, add the information gathered in the prior step for the REST API details of the source system.

In the right panel, click ¥ to add each value.

When finished, click ¥ and the system saves the data and automatically encrypts the values. They
are encrypted at the database level for security purposes.

Should you need to update them in the future, copy new values over the encrypted information and
the system re-encrypts after you save.
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Data Management Job Configuration

The metadata synchronization process is executed via a Data Management job in OneStream.
When Application Control Manager is installed, a Data Management Group named Application
Control Manager Metadata Migration (ACM) group containing associated steps is automatically
created:

.4 == Application Control Manager Metadata Migration (ACM)
&l sequences
4 3 Steps
5 Commit All Metadata Updates_ACM
5 Create Request_ACM
8 Import Account_ACM
8 Import Entity_ACM
g Import UD1_ACM
g Import UD2Z_ACM
B Import UD3_ACM
B Import UD4_ACM
B Import UDS_ACM
B Import UD6_ACM
8 Import UD7_ACM

5 Import UD8_ACM

5 Prepare Metadata_ACM

As with other features in Application Control Manager, there is a step associated with each of the
dimensions in OneStream.

To complete the setup, you must update the parameters section of the step. The EnvironmentName
parameter is entered in the initial setup step from Application Control Manager:

4 #¢ Data Management Groups * | B General (Step)

B *s Admin Name Import Entity_ACM
» == application Control Manage Descripion
» == application Contral Manage Drata Management Group Application Control Manager Metadata Migration (ACM)
¥ #e Application Control Manage Step Type Execute Business Rule
Use Detailed Logging False

4 % ppplication Contral Manage

& sequences [ Business Rule

4 3 steps Business Rule ACM_Metadataimport
S Commit All Metadata Parameters WorkflowProfileName=Migratior EnvironmentName=0A F owName=Entity
O Create Request_ACM
8 Import Account_ACKM

& Import Entity ACM

8 Import UD1_ACM

The WorkflowProfileName is always “Migration” and the FlowName matches the workflow profile
name. These two values should not be changed.
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Execution
When any of the Load <dimension name> steps are executed the following occurs:
« Prepare metadata on remote (source system)

o Using the REST API that was configured in the Application Control Manager system
administration screen, the system remotely executes a Data Management setup on the
source system named Application Control Manager Metadata Migration (ACM) ->
Prepare Metadata.

o This process gathers all metadata information including the member list, hierarchy, and
properties for the dimension specified in the workflow profile. This information is stored
in a temporary staging table in the database.

« Retrieve metadata from a remote system

o Using the REST API, make a built-in API call named GetAdoDataSetForSqlCommand
on the remote system, the system pulls the information and loads it into the local
(destination) OneStream application’s database for further processing.

« After the data is loaded into the database, the same processing that occurs during a metadata
import takes place. If any updates are required, the system automatically generates a request
which can be committed using the Application Control Manager Metadata Migration (ACM) ->
Commit All Metadata Updates Data Management step.

Request Migration

Initial Setup and Configuration

Application Control Manager can migrate requests from one OneStream environment to another.
You can use this as a testing feature to see how metadata updates will impact a production system
before committing them in that environment. You can also use it to keep two systems synchronized
with each other.

Before continuing, follow the setup steps outlined in the Metadata Synchronization section above.
You must set up a destination environment where requests will be sent.
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Add a new step to any flow you have configured in the system. In the Application Control Manager
administration screen, select Flows and edit or create a flow to use for the migration. Add a new step
to the flow after the Initiate step and select “Migrate”.

@) Flow Editor

Update - EntitySource é 2
Edit Save
*Mame  EntitySource Order 1
* Label  EntitySource Enabled? Use Tabs?
Category | Metadata v | Multiple Items? = Medify Approvers?
Security Group | Everyone - Error Template Error - Error Email

Steps | Options | Views

Edit
= =0 H | Steps - EntitySource 7l
rder ¥ StepType ¥ Label ¥ | Security Group Y Motify ¥ |Email Template ¥ | Email Address ¥

1 Initiate Initiate_EntitySource = Everyone Default

2 Migrate Migrate Everyone Default

3 Commit Commit_EntitySource Everyone Default

o v 3 Rows Page 1 of1

Click Edit:
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Specify the destination system where you want to commit the request. This was defined in the prior
configuration step.

Select the target environment:

When you create a new request in the system and advance from the initiate step you will see the
system report the next step to be “migrate”:

When you manage this request and advance to the next step, the system automatically connects to
the target environment’'s REST API and pushes the request information from the source system to
the destination environment and automatically commits the request. After reviewing and testing in
that environment, return to the source system and continue processing as you normally would.
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Help & Miscellaneous Information

This page contains solution documentation.

Display Settings

OneStream and MarketPlace solutions frequently require the display of multiple data elements for
proper data entry and analysis. Therefore, the recommended screen resolution is a minimum of
1920 x 1080 for optimal rendering of forms and reports.

Additionally, OneStream recommends that you adjust the Windows System Display text setting to
100% and do not apply any Custom Scaling options.

Package Contents & Naming Conventions

The package file name contains multiple identifiers that correspond with the Platform. Renaming any
of the elements contained in a package is discouraged in order to preserve the integrity of the
naming conventions.

Example Package Name: ACM_PV6.3.0_SV100_PackageContents.zip

Identifier Description

ACM Solution ID

PV6.3.0 Minimum Platform version required to run solution
SV100 Solution version

PackageContents File name
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Solution Database Migration Advice

A Development OneStream application is the safest method for building out a solution with custom
tables such as this one. The relationship between OneStream objects such as Workflow Profiles and
custom solution tables is that they point to the underlying identifier numbers and not the object
names as seen in the user interface. Prior to the solution configuration and to ensure the identifiers
match within the Development and Production applications, the Development application should be
a recent copy of the Production application. Once the Development application is created, install the
solution and begin design.

See also:Managing a OneStream Environment in the OneStream XF Design and Reference
Guide.

1. Inthe Production OneStream application, install the solution and create the data tables. See
Configure the OneStream Application Server for Database Server Connection settings and
installation details.

2. Datatables are created in the OneStream Development application during the solution
installation. Using the Microsoft Data Migration Assistant, copy the data from the tables to the
Production Microsoft SQL Server Database. Only the Microsoft SQL Administrator should run
the migration assistant.

Important: This process has the potential to overwrite existing table data in the production
application database if data already exists.

MarketPlace Solution Modification
Considerations

A few cautions and considerations regarding modification of MarketPlace Solutions:

« Major changes to Business Rules or custom tables within a MarketPlace Solution will not be
supported through normal channels as the resulting solution is significantly different from the
core solution.
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« Ifchanges are made to any Dashboard object or Business Rule, consider renaming it or
copying it to a new object first. This is important because if there is an upgrade to the
MarketPlace Solution in the future and the customer applies the upgrade, this will overlay and
wipe out the changes. This also applies when updating any of the standard reports and
Dashboards.

« If modifications are made to a MarketPlace Solution, upgrading to later versions will be more
complex depending on the degree of customization. Simple changes such as changing a logo
or colors on a Dashboard do not impact upgrades significantly. Making changes to the custom
database tables and Business Rules, which should be avoided, will make an upgrade even
more complicated.
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